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Welcome to the Ape Software Family! 
Thank you for Choosing Calibration Control 

Calibration Control is the calibration management software that helps you keep track of all your 

test and measurement equipment in a single location. Manage physical locations, routine 

calibrations, and histories of all your equipment. You should find that Calibration Control is easy 

to use and can handle all of your basic metrology needs. 

Use Calibration Control to meet the following major objectives: 

• Track calibration due dates 

• Manage physical locations 

• Manage records for audit trails 

• Asset management for all equipment 

Calibration Control 
Calibration Management and Tracking Software 

Thank you for choosing Calibration Control from Ape Software. 

No matter how familiar you are with this software, we are here to help. You can find various 

levels of assistance from the following sources: 

• This help document! 

• The Calibration Control Tutorials are a collection of "how to" articles that often get 

incorporated in future versions of this help file. 

• Our Calibration Control Help Forum is a great place to ask questions of technical support 

and the user community. 

• You can always Contact Us Directly via email, phone, or fax. 

http://www.apesoftware.com/calibration-management/help/
http://www.apesoftware.com/forum/forum8-calibration-control.aspx
http://www.apesoftware.com/about/contact.aspx
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Key Information 
Minimum System Requirements 

Calibration Control uses .NET Common Language Runtime version 3.5 SP1. Therefore, if your 

computer can run .NET 3.5 SP1 or higher, then Calibration Control should run properly. Please 

review the complete .NET Framework System Requirements from Microsoft for more 

information. A simplified set of requirements is presented below: 

Hardware Requirements 

1. Processor with a minimum 1 GHz 

2. Minimum 512 MB of RAM (Suggest at least 1 GB or higher for smooth operation of all 

your software) 

3. 1 GB of hard-disk space minimum if the system requires the .NET version 3.5 SP1 

framework 

4. Mouse or compatible pointing device 

Operating System Requirements 

Any version of Windows XP, Vista, or 7. 

Calibration Control Features 
The basic features of our calibration management software. 

Calibration Control gives you the choice of simple data storage using MS Access or a more 

advanced solution using your own SQL Server. Connect multiple users in your network or run 

the application on a single computer. Keep your test equipment organized and managed 

according to their individual calibration cycles, metrology lab, physical locations, type, etc. Keep 

it simple with our calibration management software. 

Basic Features 

1. Windows® DOTNET 3.5 SP1 compatibility 

2. Ability to import from previous version of Calibration Control (e.g., Calibration Control 

2000). 

http://msdn.microsoft.com/en-us/library/8z6watww.aspx
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3. Standard version for MS Access® allows you to store a MS Access® database in a 

central location on your company's network and connect multiple Calibration Control 

users to the same database. 

4. Enterprise version for MS SQL Server® allows Calibration Control to be installed on your 

company's MS SQL Server® (sold separately from an authorized Microsoft® dealer) 

gaining all the network and security features of this world-class database server. 

5. One-click sort any of the data screens (tables). 

6. Context menus and shortcut keys that allow quick access to commonly used tasks. 

7. Feature rich data grids that allow flexible customization of how data is viewed. 

8. Backup and restore data to any location. 

9. Right-click popup menus to perform the most relevant tasks. 

10. Intelligent data entry rules for cleaner data and ease of use. 

11. Storage of test equipment measurement standards and results. 

12. Pull down menus for the repetitive data 

13. Search and find specific records. 

14. Recall and equipment location reports 

15. Automatic calculation of the next calibration date. 

16. Five (5) additional user-defined fields for each equipment entry. 

Microsoft Office Style User Interface 

1. Ape Software Calibration Control has a Microsoft Office® style interface which is easy to 

learn and use, with clear graphics and an intuitive approach that makes extensive 

training sessions and manuals unnecessary. 

2. Multi-level cascading menus as in Microsoft Office®. 

3. Microsoft Office® Style Navigation Pane. 

4. Dockable and floatable toolbars as in Microsoft Office®. 

5. Tear-away menu support. 

6. Personalized menus and toolbars. 

7. Ability to modify the style of navigation pane, menu and toolbars. 

8. Support for desktop theme fonts and colors. 

9. Resizable forms for all resolution monitors. 
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Main Tool Edit Screen 

1. Individual calibration procedures can be linked to each piece of equipment. 

2. An unlimited number of calibration standards can be defined for each piece of test 

equipment. 

3. An unlimited number of measurements can be added for each piece of test equipment. 

4. A model number field has been added which allows users to specify the manufacturer 

model number of the equipment for use in quickly adding new equipment records. 

5. Create and use record templates that speed the data entry of similar pieces of 

equipment. 

6. Five (5) user-defined fields allow users to attach organization-specific data to each 

equipment record. 

History and Calibration Edit Screens 

1. Ability to store unlimited historical records. 

2. Before and After fields allow users the ability to store before and after measurements. 

3. Two sets of plus and minus tolerance fields are included to allow split tolerances to be 

defined. 

Reports 

1. Report Designer that allows users to determine exactly what data, fields and grouping 

should be included in reports. 

2. Export functions that will generate output into Rich Text Format (RTF) for word-

processing, Portable Document Format (PDF), Microsoft Excel® worksheets, HTML and 

DHTML for publishing your reports to the internet, TIFF for optical archiving and faxing 

and delimited text for spreadsheets and databases. 

3. Certification Report that prints and records calibration certificates. 

4. Additional report filters that allow filter criteria to be specified for up to three fields. 

5. Next Calibration report that allows users the ability to print any date range for future 

calibrations. 

Copyright Warning 

This computer program is protected by copyright law and international treaties. Unauthorized 

reproduction or distribution of this program, or any portion of it, may result in severe civil and 

criminal penalties, and will be prosecuted to the maximum extent possible under the law. 
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Calibration Control, Copyright © 1992-2011 by Ape Software, all rights reserved. 

Getting Help 
Using the HTML Help File 
Navigate the help file options 

The html help file is the offline help utility for Calibration Control. It eventually contains most of 

the help contents posted in the Calibration Control help section of the Ape Software website. As 

customers ask questions, we create new help topics and post them almost immediately to the 

website. As we release new versions of Calibration Control, we incorporate the material from the 

website into the html help file so Calibration Control users will have offline access to the same 

material 

Here are some basic functions of the file . . . 

 

Toolbar Buttons 

• Hide/Show: Clicking the Hide/Show button will either hide or show the tabbed 

navigation pane. 

• Back: The Back button will navigate to the page you were previously at. 

• Forward: Clicking the Forward button will navigate to the page you moved back from. 

• Print: The Print button will open a standard windows print dialog that allows you to print 

the active help document to a specific printer. 

• Options: The Options button will open a drop down menu that allows you to modify 

various properties and attributes of the Calibration Control Help program. 

• Web Site: Will take you to the Ape Software home page outside of the html help dialog. 

• About: Takes you to the introduction page of the help file. 
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Help Tabs 

• Contents: The Contents tab groups the contents of help documents by category and 

allows you to quickly look up general help information. 

• Index: The Index tab allows you to look up specific help information by a key word 

within the help document. 

• Search: The Search tab allows you to perform an advanced search of specific words 

within help documents. 

Technical Support 
Getting Help from Ape Software 

If you need help, we truly want to hear from you! 

One of the best ways to get help is through the Calibration Control help forum. If that doesn't 

work, please use one of the other methods below. :) 

Our phone numbers: 

• +1 559-868-4325 (phone) 

• +1 888-912-0021 (US toll free) 

• +1 559-420-0845 (fax) 

Through our website 

• Calibration Control Discussion Forum 

• Site Contact Forum 

• Email us at service@apesoftware.com 

Our mailing address 

7797 N. First Street #64 

Fresno, CA 93720 

http://www.apesoftware.com/forum/forum8-calibration-control.aspx
http://www.apesoftware.com/forum/forum8-calibration-control.aspx
http://www.apesoftware.com/about/contact.aspx
mailto:service@apesoftware.com
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Getting Started 
Running Calibration Control 
Starting the application 

If you used the default settings during the installation, you should find a shortcut to Ape 

Calibration Control on the desktop. 

You can also start Calibration Control by selecting it's menu option from the Ape Software 

program group in the All Programs menu. 

Product Key Registration 
Enter your product key to unlock Calibration Control 

By default, the calibration management software you install will be in demo mode until you 

enter a product key unlocking the software.  The first time you start Calibration Control, you will 

see the Ape Software Registration Wizard below. Don't worry; if you don't have a product key 

yet, you can still use the program. 

Note: If you already started the program and want to enter a product key to unlock Calibration 

Control, click the Unlock this Program from the Utilities menu to start the Registration Wizard. 
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Click the [Next] key to continue.  
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Basic information relating to system requirements and hardware requirement is listed on the 

readme page.  This is good to know if later you find that the software isn't quite working the 

way it should.  You may lack either a minimum system or hardware requirement. 

Press the [Next] button to continue. 
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On the User Information page, you can skip the 'CD-Keys' (aka product key) fields and the 

program will operate in demo mode.  Demo mode will give you full features but only last for 30 

days. 

Press the [Next] button to continue and you're done! 

 

After using the registration wizard for the first time (above), if you did not enter a product key, 

you see the following dialog each time you open the software. 

 



Getting Started 

11 

After the 30 days of demo elapse, you will see a slightly different message when you start up 

and you will not be able to open individual equipment records without entering a product key. 

 

Network Configuration 
Configure Calibration Control to create and connect to a SQL Server 

Use Calibration Control as a client/server program, with one centralized data source, using an 

existing MS SQL Server® on a dedicated computer to host the database. This will allow 

additional user workstations to access the database. The SQL Server capability requires an 

enterprise license (product keys beginning with AS10). 

Network Configuration Wizard 

If you are already using Calibration Control in MS Access mode, you can begin the SQL Server 

connection process by selecting the Network Configuration option from one of the Utilities 

menus.  Note that the Network Configuration option will only be visible if you are using a 

product key that begins with AS10 (enterprise license).  Contact Ape Software to upgrade from 

an AS09 if you need an AS10 key. 
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If you are installing your software with an AS10 product key, you will automatically be diverted 

to the following wizard after entering your key.  Upon reaching this screen, press the [Next] 

button to continue. 
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Select Installation Type 

The Client option connects you to an existing Calibration Control database. Therefore, choose 

the Client option (below) if you already have a Calibration Control database setup on one of 

your internal SQL Servers.  Otherwise, choose the Server option to create your Calibration 

Control database for the first time on one of your internal SQL Servers. 
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Select Existing SQL Server 

Either select from a list of available servers in the dropdown, or type the name of your own 

database in the Server Name field.  After a successful test of the database connection by 

pressing the [Test Connection] button, the [Next] button will become enabled and you can press 

it to move to the next step. 
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Install Database on Server 

Pay attention to this WARNING if you selected Server in Selection Installation Type step (two 

above).  If you already have an Ape Software database installed on your SQL Server and you 

continue, you will delete that database in favor of a fresh new Ape Software database with 

nothing but the original five sample records. Your database administrator can prevent this from 

happening accidently by limiting the SQL Server authority of the Calibration Control users. 

Otherwise, if everything is OK, click the [Next] button to create or connect to your 

database.  Connecting to an existing database (selecting Client in the Select Installation Type) 

should be instant.  Creating a new Calibration Control database can take anywhere from 30 

seconds to 2 minutes depending on the speed of computers involved and current network 

traffic. 

 

And that's it! You will usually need to restart Calibration Control to continue. 
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Changing the Work Environment 
Navigation Pane 
Use the customizable navigation menu to access all functions of Calibration 
Control. 

The navigation pane can emulate different styles and layouts that you can modify in the Options 

menu. 
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Change the displayed name of a menu item by right-clicking on any item and selecting the 

'Rename item' menu item. 

 

Change the size of the icon images or text of the menu item by right-clicking on one of the 

group headers (e.g., Screens, Reports, or Utilities) and selecting the desired menu option. 
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Showing and Hiding Toolbars 
Customize your toolbars 

There are three methods you can use to open the customizer to show/hide toolbars. 

 

1. Select the Toolbars option from the View dropdown menu. 

2. Click the Quick Customize button located at the right end of a toolbar, then select Add 
or Remove Buttons and Customize. 

3. Right-click anywhere on a toolbar or menu and select Customize from the context 

menu. 

Next, check or uncheck the desired toolbar from within Toolbars listbox and click close. 

Change Toolbar Icon Size 
Improve Your Working Environment 

The easiest way to change the icon size in your toolbars is to click the Small Icons and Large 

Icons selections from the View dropdown menu. 
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You can also gain a bit more control over exactly what changes sizes by selecting the Toolbars 

option of the View menu and then selecting the Options tab. 

From the Options tab you have several more choices to setup your working environment exactly 

as desired. 

 

Show or Hide Status Bar 

What's the status bar? It's the gray area at the bottom of the application with the date and time 

on the right and the page status on the left. Here's an image. 

You can show or hide the status bar by checking or unchecking the Status Bar option from 

the View menu. 

Window Menu 
Understanding the Options of the Window Menu 

The following options are available through the Window dropdown menu: 

• Cascade: Cascades any open child windows within the main program's window. 

• Close All Windows: Closes any open child windows within the main program's window. 
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• Tile Horizontally: Tiles any open child windows within the main program's window in a 

horizontal direction. 

• Tile Vertically: Tiles any open child windows within the main program's window in a 

vertical direction. 

• Minimize All Windows: Minimizes any open child windows within the main program's 

window. 

• Open Windows: Any open windows are displayed below the group line within 

the Window: menu with a check next to the active child window. 
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Selecting a Calibration Management Measurement System 
Choose Metric or US Default in Calibration Control 

Use the options dialog to change the default measurement system to either metric or U.S. 

Begin by selecting 'Options' from the 'File' dropdown menu. 

 

After the Options dialog box is open, select either 'US' or 'Metric' for your default measurement 

system. 
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Selecting a Unit-of-Measurement 
Units of Measure for Calibration Management Measurements 

Selecting a specific measurement unit is accomplished when identifying which measurements 

are required during calibration task. 

From within the 'Equipment Edit' dialog, select the 'Standards' link-button at the bottom-left 

corner. 
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If no standard measurements were previously defined, you will see the following blank 'Edit 

Standards' dialog. 
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In the 'Name' field, enter something like '10 centimeters'. The result is that the value '10' appears 

in the 'Value' field (editable) and the suffix of 'centimeters' is retained as your measurement unit. 

Click the [Add] button and a new standard measurement is added to the table within the 'Edit 

Standards' dialog. 

Note that you can enter any unit of measure, fictional or real. In the following sample, the 

example units of measure are centimeters, psi, inches, and even bluebirds. 
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Using Calibration Control 
Test Equipment Templates 
Use templates to make repetitive data entry easier. 

Templates can be created and used to quickly add new records with common data. To create a 

template, either start a new equipment master record and fill out the desired form values 

(saving not required) or open a record for edit from the Tool Browse form to use its values as 

model for the template. Next, select the Create from Current Record option from the Templates 

menu under the File dropdown, as depicted in the image below. Finally, select an appropriate 

name for your new template and press the [OK] button. 

Note: Standards and Procedures are not part of the template. 
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To apply an existing template, select the Templates > View Templates option from the File 

menu. Next select the desired template from the listbox to be applied and click the [OK] button. 

Checking the box next to a template will mark that template as the default template to be 

applied to all new records. 

 

Browse Tool (Equipment) Screen 

Use the Browse Equipment screen to search and filter for specific Equipment records. In 

additional to the common grid features, right-clicking within the record grid displays a popup 

menu providing three (3) options. 

Popup Menu Item  Description  

Highlight Past Due 
Highlights or un-highlights any Equipment records that 
are past due. 

Refresh Grid  
Refreshes the values within the grid from with those 
from the database  

Print Calibration 
Worksheet 

Generates a Calibration Worksheet for the selected 
record. 
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Edit Equipment Screen 
The main edit screen for our calibration management software 

You will use the Edit Equipment screen and its dialogs to edit all data related to your tool / test 

equipment.  You also have the ability to change the names of all fields in the Edit Equipment 

screen by updating the 'user-defined-field-names.xml' file in the application data (AppData) 

path.  The AppData path is usually the same location as the database and we already have a find 

the database help page. 

 

Review of All Fields 

• Equipment ID:  The unique identification you give your own tools / test equipment. 

• Serial No:  The unique identification the manufacturer gives their tools / test 

equipment.  You will periodically find that some manufacturers do not assign serial 

numbers or that a serial number label has fallen off.  In this case, it is usually a good idea 

that you assign one of your own. 

• Model No*:  The model number of the tool / test equipment assigned by the 

manufacturer. 
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• Tool Kit*:  A group of tools / test equipment used together for a single calibration 

purpose.  For instance, you may combine gage blocks and a flat surface to create a single 

'tool kit' used to verify the calibration to calipers.  Note: We plan to remove the tool kit 

feature after version 5.5. 

• Department*:  The department in your organization where the tool is currently located. 

• Location*:  The location within the department where the tool is currently located.  This 

could be a specific work area or even an engineer's desk. 

• Status*:  The status of the tool / test equipment (e.g., accepted, removed from service, 

failed calibration, or any other status you need). 

• Frequency / Units:  The frequency between calibrations, like yearly or semi-annual.  If 

you choose a frequency that requires a unit multiplier (e.g., week, day, or month), the 

Units field will enable where you can adjust the number of units (weeks, days, or months, 

etc.). 

• Calibration Last: The date of the last calibration is set automatically when you enter a 

new acceptable calibration (Calibrations tab).  You can also set the Calibration Last 

manually, which automatically updates the Calibration Next field based on the value of 

your Frequency field. 

• Calibration Next: The date of the next calibration is set automatically when you enter a 

new acceptable calibration (Calibrations tab) or when you manually update the 

Calibration Last field.  In either situation, the next calibration date is calculated based on 

your chosen Frequency. 

• Calibrated By:  Identify the individual, department, company (or whomever) that 

regularly calibrates this instrument.  For instance, you may have someone in the 

Fabrication department regularly calibration all calipers, someone in the Assembly 

department calibration all multimeters, and an external company that calibrates all of the 

more complicate equipment, like oscilloscopes.  This is a useful field when you want to 

create a report of all the equipment due in a given period for a specific calibration 

resource. 

• User Fields:  Use these fields for whatever additional data you team requires.  You can 

change the field names by updating the user-defined-field-names.xml file in the AppPath 

folder. 

• Notes:  Like the user fields, use the notes field for whatever purpose your team needs. 

• Tolerances:  Define the overall tolerances for the standard measurements of this test / 

measurement equipment.  Since the plus and minus tolerances are set individually, you 

have the ability to create two sets of unilateral (e.g., +/- 0.005) or bilateral (aka split) (e.g., 

+ 0.005 and - 0.002) tolerances.  Don't be confused by the second set of tolerances (i.e., 
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Tol 2) since most users will probably never use them.  Nevertheless, if the actual 

measurements you enter are out of either set of tolerances, your equipment will be 

identified as out-of-tolerance. 

• Measurements:  Click on the link button to define the standard set of measurements 

you plan on using for this piece of test or measurement equipment.  For instance, you 

have a six-inch caliper that you want to check at 1 inch, 3 inches, and 6 inches every time 

you confirm it's calibration.  Therefore, you would define three standard measurements 

for 1, 3, and 6 inches. 

• Procedures:  Relate your calibration procedures to your equipment by clicking on the 

Procedures link button and selecting the desired procedure. 

* If the field name looks like a link, you can click that link to edit the available values in the 

dropdown. 

Edit Standard Measurements 

Click on the Measurement link button (bottom-left hand corner of the Edit Equipment screen) to 

access the following dialog where you add and edit the standard measurements for each tool / 

test equipment.  Note the description of a standard measurement above (Measurements field). 

As you see below, you can use any base-10 unit of measurement you can imagine, be it 1 inch, 

15 monkeys, or 27 elephants!  When entering text in the Name field, enter it using a number 

and letter combination, something like '3 inches' and the dialog will recognize the number 3 and 

automatically enter it in the Value field for you.  Of course, even if it defaults the value, you can 

change the value to anything you need. 
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Now that you have these values entered, you can enter actual measurements during you 

calibration exercise. 
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Link Procedures to Tools 

Click on the Procedures link button (bottom-right hand corner of Edit Equipment screen) to 

show the following dialog.  The checked procedures in this dialog are the procedures linked to 

the current tool / test equipment.  If the procedure you need is not already listed, you can click 

the [Add to List] button at the bottom of the dialog to do exactly that.  You can also click on the 

Procedures menu item from the Screens group to edit, delete, or add procedures. 

 

If you have an actual document stored on your network, you can add the location of that 

document to the procedures so when you click the Link button inside the Procedures dialog, 

you will open the procedure. 
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Adding Measurements 

From within the Edit Equipment screen, select the Calibrations tab and click the [New] button 

and the following dialog will appear.  If you are entering a new calibration, the dialog will say 

Add Calibrations instead of Edit Calibrations, as it does below.  The following is an example of a 

typical record, if rejected. 

 

Click on the [Measurements] button in the Calibration dialog (above) and the following Edit 

Measurements dialog will appear where you can enter measurement based on the standard 

measurements defined in the Edit Equipment screen or on-the-fly. 
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If you enter an out-of-tolerance measurement, based on the tolerances you defined in the Edit 

Equipment screen, the record will show yellow and will force a Reject status in the Calibrations 

dialog.  The Calibrations dialog will then ask you if you want to transfer that status to the tool, 

rather than just the calibration activity. 

Grid Features 
Common Features to All Calibration Management Grids 

All of the grids in Calibration Control have the same basic features. 

Grouping Data 

All grids support an intuitive and powerful way to organize data, the 'Group By' view. The Group 

By view gives the you the ability to create custom groupings of records on the fly and to work 

with customized 'mini-datasets' that focus on just the records of interest. 

The Group By mode is similar to a concept found in Microsoft Outlook, and it works in the same 

way. When the Group By mode is enabled for a grid, a gray 'drag to' area (Group By Box) 

appears at the top of the grid. When there are no fields in this box, you will see the instruction, 

'Drag a column header here to group by that column.' You can drag column headers (fields) into 
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this area to create custom groupings. Remove fields from the header the same way, by dragging 

them out of the header. 

 

Additional Features 

1. Column Quick Change: Columns can be quickly repositioned or changed by dragging a 

column header to a desired positon within the grid or by clicking the Quick Change 

button located on the right side of the column header. 

2. Refresh: Data within the grids can be refreshed by pressing F5 or by right-clicking within 

the grid and selecting Refresh from the popup menu. 

3. Quick Sort: Clicking the header of a column sorts all records within the grid in ascending 

or descending order of the clicked column. 

4. Quick Add: A record can be added by pressing Ctrl+N or by right-clicking the grid and 

selecting New Record from the popup menu. 

5. Quick Edit: Open a record by double-clicking, pressing Ctrl+O, or by right-clicking a 

record and selecting Open Record from the popup menu. 

6. Quick Delete: Delete a record by first selecting the record and pressing Ctrl+D or by 

right-clicking the selected record and choosing Delete Record from the popup menu. 

7. Record Count: The number of records contained within the grid is indicated within the 

Grid Header. 
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8. Quick Scroll: You can scroll to the beginning or end of a row by pressing the quick scroll 

button on horizontal scrollbar in the direction of choice or by pressing the Home or End 

button on your keyboard when a row cell is selected. You can also quickly scroll to the 

first or last record within the grid by pressing the quick scroll button on the vertical 

scrollbar in the direction of choice or by pressing the Home or End button when an 

entire row is selected. 

9. Pinned Sort Column: Columns can be sorted by multiple columns by clicking the Pinned 

Sort button located in the top right corner of the column header and will be sorted in 

the order that column headers are pinned. 

10. Summaries: Columns can be summarized by the group or for all rows by clicking the 

Summaries button and selecting how the column should be summarized. Summaries are 

displayed at the bottom of the last row in the grid and after the last grouped row. 

11. Filters: Multiple filters can be applied for all columns by clicking the Filter Drop down 

button. Selecting the Custom item from the drop down list will display a dialog that 

allows you to specify custom filter criteria to be applied to the data for that column. 

Selecting the [All] item from the drop down list will remove any applied filters to the data 

for that column. 

12. Grid Splitter: When many records are returned, the Grid Splitter can be used to view 

multiple sections of the grid at the same time by dragging the Grid Splitter to the 

desired width of the grid. The grid can be split as many times as needed. 
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Using Show Fields 

Columns can be quickly rearranged or hidden using the Show Fields dialog by right-clicking 

within the grid and selecting Show Fields. 
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Click the box next to the field names in the 'Available fields' listbox then click the [Add] button 

to add the selected columns to the 'Show these fields in this order' listbox. 

To remove fields, click the box next to the fields within the right-hand listbox and then click the 

[Remove] button. 

To move the position of fields within the grid, click a field in the right-hand listbox and click the 

[Move Up] or [Move Down] buttons until the selected field is in the desired position. 

Click the [OK] button to apply the changes made and close the form or click the [Apply] button 

to apply the changes made and continue with additional changes. 

Creating Custom Report 
Create a custom 'due cal' report 

The most complicated part of creating a custom report is using a database language called SQL 

(pronounced ‘sequel’).  We use SQL SELECT statements to tell the database what fields and 

records from what tables and in what order we want our data.  As a prerequisite to this help 

topic, read the SQL SELECT statement help topic first. 
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Create Custom Report 

To begin, let’s assume that we want to create a new calibration due report for all of our 

equipment due before the end of next month.  Begin by selecting the ‘Custom Report’ item 

from the ‘Reports’ menu (see picture below). 
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Report Designer 

Clicking on the [Open] button in the Select Data Source dialog will open the Report Designer. 

This is a blank slate where you will be able to drag your fields into whatever location desired in 

the report ‘Detail.’ 
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Define Report Data Source 

If you click on the Edit Data Source link in the bottom-right corner of the Report Designer, a 

blank Report Data Source dialog will appear (below).  The Connection String field defines the 

connection to your database.  The Query field defines the fields and records we need from 

specific table and in a defined order. 

 
  



Using Calibration Control 

41 

Connection String - Choosing the Provider 

To change your connection string, click the [Build] button to the right of the Connection String 

text box and you will see the Data Link Properties.  Click on the Provider table if is not already 

displayed. 

Assuming you want to connect to an Access database (i.e., apecal.mdb), select the 'Microsoft 

Office 12.0 . . .' provider and click the [Next] button.  Otherwise, if you need to connect to an 

instance of SQL Server, you will usually need to select the SQL Server OLE DB Provider. 

If this doesn’t work, ask your database administrator (DBA) for assistance in choosing the correct 

provider. 
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Connection String - Setting the Connection 

Continuing the assumption that you need to connect to the apecal.mdb file, you need to paste 

the path to the apecal.mdb file in the Data Source field.  If you need help finding your database, 

read the locate your calibration management database help topic.  The entire path will look 

something like this: 

C:\Users\Public\Documents\Ape Software\Calibration Control\apecal.mdb  

After entering the path to your database, click the [Test Connection] button and you should see 

a ‘Test connection succeeded’ response.  If you do not get a successful response, repeat the 

above steps until you do. 
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Writing an SQL Select Statement 

Remember that you should already be at least a little familiar with SQL and that you can learn 

more about SQL by reading the SQL SELECT statement help topic.  When you are finished 

creating your SQL SELECT statement, it will look something like the following picture. 

 

Adding Fields, Labels, & Report Info 

In the following image, I performed the following actions to create My Due Cal Report: 

1. Dragged the bound fields (txtEquipmentID, txtDescription, txtLocationName, and 

txtCalibrationDate) from the right side of the page (Fields - Bound tree) to their current 

location in the Detail band and resized them to fit their contents. 

2. Selected the txtCalibrationDate field and edited is properties (bottom-right corner of 

screen) so that the OutputFormat was 'M/d/yyyy'. 

3. Dragged Label objects from the left side of the screen to locations above each field in 

the page header, resized them to fit their corresponding fields, bolded, and underlined 

them. I also created the page title (My Due Cal Report) the same way. 

4. Dragged ReportInfo objects from the left side of the screen to the left and right side of 

the footers. I clicked on each object and changed their properties (bottom-right) to . . .  

• Set the FormatString property of the datetime field to '{RunDateTime:M/d/yyyy}' 

• Set the FormatString property of the page number field to 'Page {PageNumber} 

of {PageCount}' 

• Clicked the right-align button (top of page) for the page number field. 
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5. Performed other minor tasks involving bolding, underlining, aligning, and positioning to 

make the report look the way I wanted it to look. 

   

Save Report Layout 

Save the report layout by selecting ‘Save Layout’ from the Report Designer dropdown menu. 
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Save As 

Choose a file location and name your report ‘my due cal report’. The file location usually defaults 

to the program director or the same area where the Calibration Control files are stored. 

 

Report Preview 

Select the Preview tab at the bottom of the Report Designer. 
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Print Preview 

Now it’s time to check our work! 
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Utilities 
Backup and Restore Database 
Keep your data safe by regularly backing up. 

What would happen if you lost your calibration data? I've lost all my data a few times and it's a 

bit less than pleasant; I've learned my lesson! Even if you have a backup routine, it may not be 

enough if you're not backing up you data at least daily. For instance, what would you do if you 

lost a day's worth of data? It's not a bad as losing everything, but it's still a days' worth of work. 

There are several solutions to keeping your data safe depending on if you use MS Access or MS 

SQL Server, or even if you keep you database on the same computer. Here are a few 

suggestions . . . 

Multiple Physical Locations Rule 

Always ensure that your backup location is a different physical hard [disk] drive (HDD) location. 

The farther apart those locations, the better. For instance, backing up your data from your 

computer to an external HDD is good but moving that HDD to a different room or facility is 

even better. 

Backup Options 

When you install Calibration Control, the default location for your MS Access database file is on 

the same computer you install the software. See the help topic on locating your database to find 

the specific location. In this situation, if your hard [disk] drive (HDD) crashes you will lose 

everything on that HDD. Therefore, your backup plan must include storing your backup data on 

a data storage device other than that of your computer. 

If you are using the SQL Server version of Calibration Control, the location of your database (an 

MDF file) is controlled by your SQL Server. Depending on your choices during installation or 

migration (from MS Access to MS SQL Server), your database could be on the same computer or 

it could be somewhere on one of the servers in your network. 
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Whether you use Access or SQL Server, you have two primary backup options . . . 

1. Use your own backup routine to backup you database, and other important files, to a 

remote location. The remote location is an external storage device (e.g., HDD or key) or a 

network location other than the current computer. 

2. Use the following Calibration Control backup routine to safeguard your calibration 

data. 

You can use the Calibration Control Database Backup utility to create backup copies of the 

database. Find the Database Backup utility within one of the utilities groups (see next figure) and 

click Backup Database. 
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To use, select a file name for your backup; something like a date code and 'calibration_backup' 

work well. Next, select the location or file path to backup to and then click the [Backup] button. 

Remember to choose an HDD location other than then HDD where the live database is stored. 

 

A success message is displayed if the backup operation was successful. 

 

If possible, try to keep your backup data, or at least one copy of it, in a separate physical 

location. 
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Restoring a Database 

Restoring a Calibration Control database is the same process whether you're using an Access or 

SQL Server database. 

Warning: Restoring a database completely overwrite the current data. If you are not sure that 

this is what you want to do, make a dated backup of the current database contents before 

restoring a previous version of your database. 

1. Close all open screens, especially the main Tool Browse screen. 

2. From within Calibration Control, click on the Restore Database option (directly below the 

Backup Database) option in the Utilities menu. 

3. Click [Browse] from within the Restore Database dialog to navigate to select the backed 

up database you wish to restore. 

4. Click the [Restore] button. Pay attention to the warning dialogs. 

5. When you're done, click the [Close] button on the Restore Database dialog. 

 

If you left any data screens open, you will need to refresh or close and reopen to see the 

restored data. 
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Importing Data 
Import data from previous versions of Calibration Control 

If you have data in version 4 of Calibration Control or you want to migrate your data from an MS 

Access version to a SQL Version, the following instructions can help. 

Choose Version 

Begin the import process by selecting the Import Wizard in the Utilities menu and you will see 

the following dialog in you are using SQL Server. This dialog is skipped if you are not using SQL 

Server. 

You have a choice of importing from the pervious version 4 Access database or from a version 5 

Access database. Version 4 did not use SQL Server. The version 4 Access filename is usually 

'cc2000.mdb' and the version 5 Access filename is usually 'apecal.mdb' (unless you changed 

either name). 

Select the appropriate input format and click the [Next] button to move to the next step. 
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Source Directory 

Click the [Browse] button and navigate to the Access file you need to import and then click 

[Next]. 
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Transfer Data 

Note that if you try to import records from the source database to the current database and the 

record already exists, the import process will ignore those records. For instance, if you are 

importing from a version 4 database and one of the equipment records has an ID of '121' and 

your current database has a MasterID of '121', then record 121 will be ignored. Therefore, 

correct ID discrepancies before transferring data. 
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Program Options 
Modify application settings 

You can modify the Calibration Control program options by selecting Options from the File 

dropdown menu. 

 

• The Menu / Navigation Pane Appearance dropdown changes the style and color 

scheme to match that of MS Office XP, 2000, 2003, and 2007.  The default is Explorer 

2007 because we thought it looked the nicest. :) 

• The Navigation Pane Style dropdown changes the Navigation Pane to the MS Outlook, 

Listbar, Toolbox, Explorer and Visual Studio 2005 styles.  The default is Explorer for the 

same reason as above. 

• The Measurement System dropdown switches the default measurement system 

between U.S. and Metric, while the default is U.S. 

• The First Day of Week setting is used when calculating the calibration due date with the 

'week of' frequency.  For instance, if a tool has a calibration frequency of 'week of' and a 

unit multiplier of three (i.e., every three weeks), Calibration Control will calculate the next 

calibration date by adding three weeks to the last calibration and then choosing the first 

day of that week (as determined by this setting). 

• The Offset for 'Week/Month of' Due Dates setting is used while calculating the 

calibration due date for the 'week of' and 'month of' frequencies.  For example, if a tool 

has a 'month of' frequency, a 12 unit multiplier (i.e., every 12 months), and the offset for 
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the program is 'next' (this setting), the calibration due date is calculated by adding 12 

months to the last calibration and then choosing the first day of the next month.  In this 

case, the tool is now due the 'month of' this calculated month. 

• By default, Calibration Control checks for available updates on startup and informs the 

user that a new update is available. 

Advanced Topics 
Locate Calibration Control Database (MS Access) 
Find the database and configuration files 

By default, the apecal.mdb database is stored in the data & settings folder unless you moved 

the database to another location, like a network folder.  The data & settings folder is different 

for different versions of Calibration Control and different operation systems. 

Version 5.5 and Higher 

The easiest way to find the data folder in versions 5.5 and higher is to select the Open Data 

Folder Option from the File dropdown menu. 
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Otherwise, the data folder for versions 5.5 and higher is in one of two locations, depending on 

which operating system you are using. 

Windows Vista, 7, Server 2008 
C:\Users\Public\Documents\Ape Software\Calibration Control  

Windows XP 
C:\Documents and Settings\All Users\Documents\Ape Software\Calibration 
Control  

Version 5.0 to 5.4 

Unlike versions 5.5 and higher (above), there is no menu item that will help you navigate directly 

to your data & settings folder.  This is another small reason to download the newest version 

today. 

Windows Vista, 7, Server 2008 R2 

If you are using Windows Vista or 7, you will find your database file under the application data 

(AppData) folder of either the person who was logged in during installation or under the 

AppData folder of your ‘Public’ user.  For instance, take my situation.  I was logged in when I 

installed Calibration Control and my user name is ‘Mark’.  Therefore, I can find my data & 

settings folder at: 

C:\Users\Mark\AppData\Local\VirtualStore\Program Files\Ape Software\CCV5  

Generally statued you will find your data & settings folder at . . . 

C:\Users\[Your Name Here]\AppData\Local\VirtualStore\Program Files\Ape 
Software\CCV5  

. . . by replacing my name with yours. 

Windows XP 

If you use an operating system like Windows XP and you, or the person who installed Calibration 

Control, did not choose an alternate location for the database, you will find the data & settings 

folder in the program folder (or application path) at: 

C:\Program Files\Ape Software\CCV5  

Note that depending on your hard drive configuration, your ‘Program Files’ may be stored on 

another letter drive other than ‘C:\’ although ‘C:\’ is the most common. 

http://www.apesoftware.com/calibration-control/download.aspx
http://www.apesoftware.com/calibration-control/download.aspx
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Other Location 

If your apecal.mdb file is not located in the folders described above, you can find the path to 

your database inside the general.config file located in either of the two folders described 

above.  Unlike the apecal.mdb file that you can move anywhere, the general.config file remains 

in one of these two locations so you should be able to find it. 

After finding the general.config file, open it either by double-clicking or using a common text 

editor like Notepad.  If your apecal.mdb file is not in one of the two folders described above, you 

will see a value in the DatabasePath key (below) that indicates the current location of your 

database (see image below). 

 

Move Calibration Management Database 
Move Calibration Control Database to New Location 

Users will often need to move their calibration management database file (apecal.mdb) from the 

original location, where it was first installed, to a new location. You might even want to make the 
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database file easier to backup or to place it in a more central location so other users can 

connect. 

Close Calibration Control 

Before moving your database file, ensure that your Calibration Control application is closed. 

Find Database File 

Before you can move your ‘apecal.mdb’, you'll need to find it. If you need help, see the help 

page on finding your database file before moving to the next step. 

Move Database File 

Chose your new location either on a shared network or the same computer and move your 

‘apecal.mdb’ file from its original location to your new location. In the following example, I 

decided to move my file to the new location: 

 

Note: If you move your database file to a network location, you must grant appropriate user 

permissions to that new location depending on who needs access. 
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Point Calibration Control to New Location 

Point your calibration management software to the new location by starting the application. 

When Calibration Control discovers that the ‘apecal.mdb’ file is missing from its known location, 

it will show you the following ‘Database File Not Found’ dialog: 

 

From within this dialog, select ‘Point to a New Database File’ and click the [OK] button. Browse 

to and select the new database location and click the [Open] button. 
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Your calibration management application should start as normal and will remember this new 

location. 

Multiple Users of Calibration Control 
Multiple users with the MS Access version of our calibration management software 

Setting up multiple users to access our calibration management software (Calibration Control) is 

as easy as deleting a file, starting the application, and linking to the new file.  Therefore, you 

should be familiar with the help topics for finding your database and moving your database and 

you will have all the skills you need to add multiple users to your calibration management 

system. 

But just in case, let's be a bit more explicit with the following steps: 

Move Your Database 

Find your database and move your database to a network location where all of your users have 

read-write access.  Most of the difficulties users experience with implementing a multi-user 

environment have something to do with network folder permissions.  So if you experience any 

difficulties, you should first seek assistance from your network administrator. 

Note that the only file you need to move to your shared network location is the 'apecal.mdb' 

database file. 

Add Additional Users 

For each new client (user computer) you will need to install a new instance of Calibration Control 

and delete the default 'apecal.mdb' file that is installed with the application. 

After you delete the apecal.mdb file on the new client, start Calibration Control on the new client 

and you should see the following Create New Database dialog: 
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Within the dialog, click the [No] button and a open file dialog will appear where you can then 

navigate to the location of your network apecal.mdb database. 

That's it!  If you have any questions, please post them in the Calibration Control forum. 

http://www.apesoftware.com/forum/forum8-calibration-control.aspx
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Reports 
Standard Reports 
Using Standard Reports 

How to Access and Use Default Reports 

You can access the standard reports either from the Actions dropdown menu or through the 

navigation pane on the left side of the work area. 
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Standard Reports 

The Standard Reports dialog appears providing the choices of simple reports (no grouped data), 

grouped data reports, and other reports. For this experiment, select the Equipment Listing 

report under the Simple Reports. 
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Filter Options 

If we wanted our report to include all equipment, then we would click the [Execute] button and 

the new report would appear. For this example, let's assume we only want to include the 

equipment due calibration before the end of May, 2011 and only for those departments that 

begin with 'qc'. 

To create our filtered report, click the [Options >>] button to display the Filter Options. Click the 

green plus button [+] twice to get two sets of filter controls and complete the fields as 

illustrated in the image below. Note that the 'Calibration Next' value is set for less than [<] 

6/1/2011, which will include all calibration due dates before June begins. If we entered 

5/31/2011 as the Filter For date, the filter would include all days in May except for the last day. 

 
 
  



Reports 

65 

Report Preview 

When you are finished entering your filters, click the [Execute] button and the following report 

preview will appear (without the red lines).  Click on the image below to see a full size image. 
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Calibration Report Preview 

Several options when previewing a report. 

This is the standard report preview used both with existing reports and for your own custom 

reports. Move between pages, adjust the zoom level, view the report in a continuous scroll, and 

perform text searches within the report. You can even export your reports to several different 

formats, including HTML, PDF, rich text (RTF), text (TXT), TIFF, and Excel. 

 

Create Simple Custom Report 
Creating Custom Report 

Create a custom 'due cal' report 

The most complicated part of creating a custom report is using a database language called SQL 

(pronounced ‘sequel’).  We use SQL SELECT statements to tell the database what fields and 

records from what tables and in what order we want our data.  As a prerequisite to this help 

topic, read the SQL SELECT statement help topic first. 
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Create Custom Report 

To begin, let’s assume that we want to create a new calibration due report for all of our 

equipment due before the end of next month.  Begin by selecting the ‘Custom Report’ item 

from the ‘Reports’ menu (see picture below). 
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Report Designer 

Clicking on the [Open] button in the Select Data Source dialog will open the Report Designer. 

This is a blank slate where you will be able to drag your fields into whatever location desired in 

the report ‘Detail.’ 

 
Define Report Data Source 

If you click on the Edit Data Source link in the bottom-right corner of the Report Designer, a 

blank Report Data Source dialog will appear (below).  The Connection String field defines the 

connection to your database.  The Query field defines the fields and records we need from 

specific table and in a defined order. 

 



Reports 

69 

Connection String - Choosing the Provider 

To change your connection string, click the [Build] button to the right of the Connection String 

text box and you will see the Data Link Properties.  Click on the Provider table if is not already 

displayed. 

Assuming you want to connect to an Access database (i.e., apecal.mdb), select the 'Microsoft 

Office 12.0 . . .' provider and click the [Next] button.  Otherwise, if you need to connect to an 

instance of SQL Server, you will usually need to select the SQL Server OLE DB Provider. 

If this doesn’t work, ask your database administrator (DBA) for assistance in choosing the correct 

provider. 
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Connection String - Setting the Connection 

Continuing the assumption that you need to connect to the apecal.mdb file, you need to paste 

the path to the apecal.mdb file in the Data Source field.  If you need help finding your database, 

read the locate your calibration management database help topic.  The entire path will look 

something like this: 

C:\Users\Public\Documents\Ape Software\Calibration Control\apecal.mdb  

After entering the path to your database, click the [Test Connection] button and you should see 

a ‘Test connection succeeded’ response.  If you do not get a successful response, repeat the 

above steps until you do. 
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Writing an SQL Select Statement 

Remember that you should already be at least a little familiar with SQL and that you can learn 

more about SQL by reading the SQL SELECT statement help topic.  When you are finished 

creating your SQL SELECT statement, it will look something like the following picture. 

 

Adding Fields, Labels, & Report Info 

In the following image, I performed the following actions to create My Due Cal Report: 

1. Dragged the bound fields (txtEquipmentID, txtDescription, txtLocationName, and 

txtCalibrationDate) from the right side of the page (Fields - Bound tree) to their current 

location in the Detail band and resized them to fit their contents. 

2. Selected the txtCalibrationDate field and edited is properties (bottom-right corner of 

screen) so that the OutputFormat was 'M/d/yyyy'. 

3. Dragged Label objects from the left side of the screen to locations above each field in 

the page header, resized them to fit their corresponding fields, bolded, and underlined 

them. I also created the page title (My Due Cal Report) the same way. 

4. Dragged ReportInfo objects from the left side of the screen to the left and right side of 

the footers. I clicked on each object and changed their properties (bottom-right) to . . .  

• Set the FormatString property of the datetime field to '{RunDateTime:M/d/yyyy}' 
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• Set the FormatString property of the page number field to 'Page {PageNumber} 

of {PageCount}' 

• Clicked the right-align button (top of page) for the page number field. 

5. Performed other minor tasks involving bolding, underlining, aligning, and positioning to 

make the report look the way I wanted it to look. 

   

Save Report Layout 

Save the report layout by selecting ‘Save Layout’ from the Report Designer dropdown menu. 
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Save As 

Choose a file location and name your report ‘my due cal report’. The file location usually defaults 

to the program director or the same area where the Calibration Control files are stored. 

 
Report Preview 

Select the Preview tab at the bottom of the Report Designer. 
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Print Preview 

Now it’s time to check our work! 

 

Select Filter Options Dialog 

Larger image of the dialog . . . 

The Create Custom Reports function of Calibration control uses this Select Data Source dialog to 

allow users to select the predefined data sources (e.g., tables and views of tables) and to add 

custom filter options.  

The Editable Data Source option gives advanced users the ability to modify the existing 

connection string and SQL (structured query language) for the report. The report uses the 

connection string to point and connect to the database while the SQL tells the database what 

data, data filters, and order to deliver to the report. 

The Filter Options, on the right side of the dialog help users to build the needed SQL that 

creates filters and sorts against the chosen table or view. When users select the Editable Data 

Source option they will have the ability to edit the SQL built by the Filter Options. 
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Report Designer Dialog 

Larger image of the dialog . . . 

Use the report designer to create and modify custom reports for Calibration Control (calibration 

management software). You can drag and drop fields, format the way each field displays, create 

footers and headers specific to your organization, add your own pictures or logos, and even add 

barcodes.  

With the report designer, you can change the connection string to point to different data 

sources (e.g., Access or SQL Server) and edit the SQL (structured query language) the report uses 

to draw data from your chosen data source. 
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Custom Report Print Preview 

The result of creating a simple report. 

The following custom report was created by dragging four fields (i.e., equipment ID, description, 

location, and due cal) and labels to the correct location in a report designer. The fields were 

dragged and adjusted to their appropriate size. The labels were placed over the fields and the 

user entered whatever column description was appropriate. The ‘My Due Cal Report’ is also a 

label dragged to its location and adjusted for size. Easy! 
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Create Advanced Custom Report 
Understanding the SQL SELECT Statement 

Useful with Calibration Management Software Reports 

SQL (pronounced sequel) stands for Structured Query Language. SQL is the basic language of 

most common databases, including MS Access and MS SQL Server, the two databases we use 

with Calibration Control. The part of the SQL language we need to focus on is the SELECT 

statement, which we use to retrieve information from our calibration management software 

(Calibration Control). Although SELECT statements are used by reports, web pages, on screen 

displays, and even moving data between applications, we will need SQL primarily for reports. 

A Primer on Tables 

Before we get started, let’s make sure we understand the source of our data when we use a 

SELECT statement. Within a database, information is stored in tables that look something like a 

spreadsheet with columns and rows. Unlike a spreadsheet, a table uses records (horizontal rows) 

and fields (vertical columns). 

Think of each record as if it were a photocopied standard form that you use for keeping track of 

your test equipment and that you keep all these forms in a file. The file may have a hundred 

forms, each with information describing a specific piece of test equipment. Just like a table, you 

can sort your forms in a different order and you can find records by scanning a single field on 

each form; it just takes a bit longer with paper compared to a database table. 

The Equipment Master View 

Within Calibration Control, you will probably derive most of your reports from the 

qryEquipmentMaster view (also called a query) because it has most of the fields you need for 

your test equipment records. The fields in the view will also be easier to read than their 

corresponding codes in the root table. Think of a view as a way to pre-package part of the SQL 

complexity that makes your data easier to work with. 

As an example, if you look at the contents of the tblEquipmentMaster table (where your data is 

actually stored) you’ll see fields like ModelNumberID with meaningless numbers in the fields 

(see image below). On the other hand, if you look at the qryEquipmentMaster, you’ll see the 

actual model numbers and descriptions that you’re familiar with. This is because the view has 



Reports 

79 

SQL code in it that looks up and displays the meaning of the ModelID code so you don’t need 

to. 

 
The SQL SELECT Statement 

There are four main parts of the SELECT statement that we need to cover. 

• SELECT – (IDs fields from a table that will be included.) 

• FROM – (IDs the table where the fields come from.) 

• WHERE – (Defines the filter that includes only the records you want to include.) 

• ORDER BY – (Defines the sort order of the records.) 

While the SELECT and FROM clauses are always required, you will only need to include the 

WHERE and ORDER BY clauses when you want to filter and sort. Otherwise, your results will 

include all records and in no particular order other than the physical order of the underlying 

table. 
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Here is an example of a common SQL statement you would use to return all the fields from the 

qryEquipmentMaster view: 

SELECT * 
FROM qryEquipmentMaster;  

Pretty easy, right? Notice the asterisk (*)? The asterisk is a wildcard that includes all fields. With 

the relatively easy SELECT statements that we need in our calibration management software, 

using the wildcard is usually your best bet because you don’t need to worry about whether you 

forgot a field or not when you’re designing your report. 

Now let’s assume that we want to filter and sort our results in the following example: 

SELECT * 
FROM qryEquipmentMaster 
WHERE DepartmentCode = 'QA' 
ORDER BY Location; 

You can even add multiple filters and multiple sorts with the following MS Access: 

SELECT * 
FROM qryEquipmentMaster 
WHERE (DepartmentCode = 'QA') AND (CalibrationDue <#5/1/2011#) 
ORDER BY Location DESC, SerialNumber;  

Note that the date value has number signs (#) around it rather than the single quotes of the text 

values? You need to use the # sign when you are using MS Access and the single quote (‘) when 

using SQL Server. Although both databases use SQL Server, there are still slight differences. 

Here's the same code for MS SQL Server: 

SELECT * 
FROM qryEquipmentMaster 
WHERE (DepartmentCode = 'QA') AND (CalibrationDue <'5/1/2011') 
ORDER BY Location DESC, SerialNumber;  

The final example deals with filtering for numeric values and is compliant with both MS Access 

and MS SQL Server. Note that the value (1) uses neither the single quote (‘) or the number sign 

(#)? 

SELECT * 
FROM qryEquipmentMaster 
WHERE FrequencyUnits = 1;  

You can learn more about the SQL SELECT statement through an Internet search. If you can 

think of any good beginner SQL sites, let me know and I can post a link on this page. 
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Open Custom Report 
Print or edit custom / user reports. 

Select the Open Custom Report option in the Reports menu to open a dialog giving you the 

option to print or edit an existing custom report. 

 

Select the Design option if you want to open the Report Designer to modify its design or select 

the Preview option to view a print preview. Click the [OK] button to execute your choice. 
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